
1

REF

Preview
REFERENCE



   

2

Copyright and Trademark

Please read the license agreement in the ’Getting Started’ booklet
carefully. Subject to technical alteration.

All rights reserved. Subject to change without notice.
Release 4700; Subject to technical alteration.

Printed in Germany

AIST - Animated Image Systems Technology GmbH
Mobil-Oil-Str. 31
84539 Ampfing
Germany
Tel.: ++49 (86 36) 98 35 0
Fax: ++49 (86 36) 98 35 22
Internet: http://www.aist.com (English)
Internet: http://www.aist.de (German)
E-mail: info@aist.com

© 1997 - 2000 AIST - Animated Image Systems Technology GmbH
Manual Tutorial Reference Effects
Copyright and Trademark
Reference REF



   
PREVIEW

Contents

Live Preview in Realtime .................................................................  6

Animation Preview .........................................................................  7

Opening the Preview Window ........................................  7

Preview Setup ...............................................................  8

AIST OpenGL Renderer ..................................................  8

AIST Direct3D Renderer..................................................  8

M3 Final Renderer.........................................................  8

ProPro Renderer ............................................................  8

Setting up the Preview....................................................................  9

Adjusting Preview Area..................................................  9

Changing Preview Area .................................................  9

Preview is too Long........................................................  9

Lengthening and Moving Preview Area ............................  9

Time Display .................................................................  9

Mesh .........................................................................  10

Source Viewer..............................................................................  11

Video Control...............................................................................  13

Opening Video Control ................................................  14

Adjusting Video Boards ................................................................  14

Selecting Playback Module...........................................  14

Without a Video Board ................................................  15

Video Board with MJEPG 15

Fast AV/DV Master......................................................  16

Miro Instant Video .......................................................  17

DV board using FireWire .............................................  19
Contents
Preview REF 3Manual Tutorial Reference Effects



   

4

Sony Vaio ...................................................................  20

DPS............................................................................  21

Activating Video Control................................................................ 21
Manual Tutorial Reference Effects
Contents
Preview REF



   
Previews make your work easier and MoviePack provides you with the
best visual control of your work.

The Preview (Live Preview in Realtime) does not affect the computing capacity
in any way. It is an extremely important tool for processing short
sequences as it provides you with a constant overview of the results of
your manipulations of the animation.

The Source Viewer provides you with a preview of the source material.

Video Control is also another type of preview which allows you to examine
longer clips before the final rendering and you can even view them on
a TV monitor.

Ref Preview Titel
Contents
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Live Preview in Realtime  

Shows animation 

Skip button: Starts preview at the start of Preview area, 
or use Ctrl + left arrow.

Time display: Displays 
current project time in 
hours/minutes/seconds 
and frames. Specific 
time can also be 
entered.

Single frame button: Moves preview backwards one 
frame at a time, or use left arrow key.

Scroll bar: Fast search 
backwards and for-
wards.

Starts Preview, can also use Spacebar.

Stops the running Preview.

Single frame button: Moves Preview forward one 
frame at a time, or use right arrow key

Skip button: Starts preview at the end of Preview area, 
or you can also use Ctrl + right arrow.
Manual Tutorial Reference Effects
Live Preview in Realtime
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Animation Preview 

The Preview window (Live Preview in Realtime) acts as a constant image
control. Even when running the Live Preview in Realtime for the first time you
get a very good idea of how the final animation will look. However
depending on the capacity of your PC you will notice that in the first
Preview some frames are skipped in critical places so as to ensure that
those frames already calculated appear at the right time.

In the following runs these frames, which were missed out, will also
have been calculated and stored in the video cache (proxy). The Live
Preview in Realtime then shows all of the frames together and runs
smoothly.

The Preview shows either the entire animation or the frame on which the
Timeslider in the Timeline and Timegraph is positioned.

Opening the Preview Win-
dow

u Open the Preview by clicking the  Activate Preview icon on
the window icon bar or under View / Palette / Preview.

u Click the Play button  in the Preview window to start the
Live Preview in Realtime.

Right-click in the Preview window and a
list of check boxes appears which
enable you to adjust the Preview. The
following functions can be activated or
deactivated; Maintain Frame Rate, Auto
Repeat, Ping-Pong. If Enable Sound is
activated the audio track is played. Audio
Scrubbing allows you to find an exact beat
in the audio track. Settings for the Preview are determined in Preview Setup.

The command Preview Setup is also
found in the Render menu.
Animation Preview
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Preview Setup In Preview Setup you can determine the display quality of the Preview as
well as the rendering speed.

I The secondary renderer calculates the embedded scenes.

AIST OpenGL Renderer With this renderer you can see the Preview surprisingly quickly. The
quality is sufficient for small Preview window displays. As this renderer
does not support Alpha Channel, transparancies will be displayed
either incorrectly or not at all.

AIST Direct3D Renderer The AIST Direct3D Renderer offers you excellent display quality at a
high rendering speed.

M3 Final Renderer M3 Final Renderer offers highest quality output however it requires
slightly more rendering time than the OpenGL renderer.

ProPro Renderer This provides an alternative to the M3 Final Renderer.

We recommend that you try out the different renderers and then decide
which one gives you the best results for the job in hand.

Ref_Vorschau_004 und 004b
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Setting up the Preview

Adjusting Preview AreaAfter starting up MoviePack a green preview bar appears in the Timeline
and the Timegraph which, starting from 0, is set at a preview time of 3
seconds and 15 frames. If the objects are longer or shorter than the
preview bar, double-click the bar to fit it to the length of the object.

Changing Preview Area u Double-click in the preview bar line to alternate between the
previously chosen preview area and the entire Preview.

Preview is too LongI If you have a preview area that is longer than 10 seconds it
is better to switch to Video Control.

Lengthening and Moving 
Preview Area

 u The preview area can be moved. Position the pointer over
the preview bar and the pointer changes to this . You
can then click and drag the bar in either direction. 

 u By placing the pointer on either end of the preview bar, you
can lengthen or shorten it.

 u By pressing Ctrl you can move the bar in both directions
starting from where the pointer is positioned.

Time Display u Click one of the digits in the Time Display and it will start to
blink. New digits can now be entered using the arrow keys
or the alphanumeric keys on the keyboard. The left/right
arrows allow you to move from one digit to another while the
up/down arrows allow you to raise or lower the digit value.
Press Return when you have entered all the digits.

Ref_Vorschau_004c
Setting up the Preview
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u Click here  and the Preview jumps to the beginning of the
preview area. Click the other double arrow button and it
jumps to the end. Alternatively use shortcut Ctrl + arrow keys.
Click Play  and the button immediately changes to Stop

. Click again and the Preview is stopped. The Spacebar can
also be used to stop and start.

u Click here  and the Preview jumps forward one frame.

u Click the slider  and you can drag it either right
or left. The Preview will then follow the direction in which you
pull the slider.

I Scrolling enables you to quickly locate and survey frames. By
freely moving backwards and forwards difficult cuts can be
judged.

Mesh Only with the AIST OpenGL renderer can the wire frame be selected
under Configure. Forms can then be identified better. The colors remain
the same.

The wire frame or
Adaptive Mesh Technology
from AIST fits the
requirements exactly.
Where minor
deformations have
taken place the wire
frame is regular. The
wire frame becomes
more complex and
structured if
deformations are
more complex. 
Manual Tutorial Reference Effects
Setting up the Preview
Preview REF



   
Source Viewer

Sources appear as thumbnails in the Browser window. The Source Viewer
displays these thumbnails in larger form and runs the animations. To
activate this function click the eye icon in Browser. As soon as the pointer
is positioned over a source, the Source Preview appears. Alternatively
right-click an object to activate the Source Preview.

Right-click in the Browser window to select settings for the Source Preview.

u Position the pointer over a
thumbnail. A preview of the
animation of a clip or an
enlarged view of the still
image appears. Move the
pointer away from the object
and the Source Preview
disappears.

u Click the thumbnail and
the Source Preview becomes
permanent. You can now
move the pointer around the
window and using the slider
or green buttons view selected
frames. The window can also
be enlarged, moved or
closed.

The slider and buttons can only be found in the source previews of
animations and sound. Still images are displayed in a straightforward
window which does not possess these control buttons.

To enlarge the green buttons right-click in Source Preview and select Large
Buttons. Under Customize / Playback you can adjust the icon bars and
rearrange the playback buttons. Place the pointer over the IN / OUT / INS
buttons and a description of their function appears (tool tips). 

 INS inserts the object being viewed onto the Canvas.
Source Viewer
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If you want to insert only certain sections into your project, unwanted
sections can be cut away.

To do this you need
both the IN and OUT
buttons.

The IN button deletes
everything to the left
of the Play slider. By
clicking the OUT
button everything to
the right of the Play
slider is deleted. The
edited version of
your project is then
played by clicking
the INS button.

Sound files can be
listened to and
edited as well.
Manual Tutorial Reference Effects
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Video Control   

Scroll bar: Fast 
search backwards 
and forwards

Time Display: 
Displays current project
time in hours/minutes/
seconds and frames.
Specific time can also
be inserted.

Transmits rendered clip onto a
monitor Activates Preview rendering 

Settings for output and
memory management

Skip button: Skips to the beginning of preview area.

Single frame button: Skips backward one frame.

Starts preview.

Stops preview.

Single frame button: Skips forward one frame.

Skip button: Skips to the end of preview area.
Video Control
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Video Control is for previews of longer animations which are then output
onto a TV monitor. Before the final rendering you can obtain a preview
similiar to the final output when using this function.

As opposed to a conventional preview renderer, which constantly
renders and immediately manages modified or unmodified clips, the
AIST Intelli-Renderer differentiates between the two. Only those sections
of a clip that have been modified since the last rendering are re-
rendered. However transition tracks are always rendered.

I Unlike the Live Preview in Realtime, when using Video Control you
must render your animation each time you make a change or
an adjustment.

ï Output to a monitor should be used only for testing. If the
monitor is constantly fed data, the processing speed will
suffer.

Opening Video Control Click the  Activate Video Control icon in the window icon bar.

Adjusting Video Boards

Selecting Playback Module Video Control works in conjunction with different playback modules.
Which modules you can use depends on your hardware configuration.

u From the Tools menu select Capture/Playback Hardware.
Manual Tutorial Reference Effects
Adjusting Video Boards
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On the left are the installed plug-ins for different boards. On the right
you can select either the AVI Playback (for use with MJPEG hardware)
or an IEEE 1934 board which will use DV hardware.

The text at the bottom shows the currently active plug-in and the plug-in
that will be used after restarting MoviePack.

 u Select the available playback module for your system. Restart
MoviePack to activate the selected playback module.

Without a Video BoardWhen you first start up MoviePack it is assumed that no video board
has been installed. ’Standard AVI Playback’ is used as a playback
module and allows the direct playback of all Microsoft standard AVIs
which are compressed with a software codec or a MJPEG codec. 

Video Board with MJEPGMany video boards compress video files with the MJPEG codec. With
such a video board it is possible to view the animation of the selected
preview area also on a TV monitor. For this you must select the
corresponding video codec:

 u Click S and under Compressions-Options select the video codec
suitable for your board.

Depending on your hardware support, you can output the current
content of the Canvas onto a connected TV monitor for testing.

 u Click the  Show Canvas on Monitor icon in the Video Control win-
dow to output the current content of the Canvas onto a connec-
ted TV monitor.

ï MoviePack must be restarted as soon as the settings are
changed.
Adjusting Video Boards
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I Standard AVI Playback is installed when you start up
MoviePack. All Microsoft Standard AVIs, which are folders
with software codecs or MJPEG codecs, can be used. This
way it is possible to use videos that have been bought or
copied from the Internet.

Video boards which support Video Control can be found on the AIST web
site (http://www.aist.com). You should specify the hardware you are
using after starting up MoviePack.

u Click the  Activate Monitor icon and the content of the Canvas
is displayed on the monitor. If your video board does not
support this feature the icon is blurred and cannot be
activated.

Fast AV/DV Master For AV and DV Master use the specially designated playback module:

 u In the Tools menu click Capture/Playback Hardware and in the right-
hand window select ’Fast AV Master AVI Playback’ or ’DV
Master AVI Playback’. Restart MoviePack to activate the
playback module. 

For the AV
Master you
receive these
options.
Manual Tutorial Reference Effects
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Click the Render button and the Canvas content is displayed only on the
connected TV monitor.

Both boards support output onto a monitor.

 u Click the  Show Canvas on Monitor icon in the Video Control
window to output the current content of the Timeline onto a
connected TV monitor and not to Video Control.

For the AVMaster the parameters shown below are available:

Miro Instant VideoAn additional plug-in must be installed for the following boards: Miro
DC 30, DC 50, DC 100, DV 500 etc. Pinnacle is developing its boards
specifically for Adobe Premiere.
Adjusting Video Boards
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u From the Tools menu or with a right-click in the Video Control
window choose Options. In the File Locations tab (see the
’Reference - Project Management’ booklet) type in the Instant
Video installation path, it is normally
C:\Programme\Adobe\Premiere\Plug-in.

After restarting, under Tools / Capture/Playback Hardware you can select this
plug-in

ï Install the plug-in as follows: 
1. Install Premiere
2. Install Plug-in
3. Restart MoviePack
4. Choose Playback
5. Restart MoviePack
Manual Tutorial Reference Effects
Adjusting Video Boards
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In Setup (S)
this menu
appears.

In Audio Setup you can choose from different frequencies and the Bit
Depth.

DV board using FireWireIf you are using a DV board (IEEE 1394 compatible) the digital video
signal can be viewed only on a DV compatible device, i.e. a monitor
with DV input. It is possible to use a DV camera provided it has active
DV input. Usually only high-end devices possess this function. 

ï The analog ouput from a suitable camera is normally
connected to a conventional monitor. 

Before you start MoviePack ensure that the DV device is connected to
the FireWire cable and if necessary in VCR mode. As the DV device is
a part of the Video Capture hardware, you should not switch the DV
device on and off during use as this can cause problems. 

ï If a digital video camera is connected by a FireWire cable,
it will automatically be recognised by MoviePack.
Adjusting Video Boards
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Under Capture/Playback Hardware IEEE 1394 DVCR is now available. These
settings are obtained under S.

 u In the Tools menu click Capture/Playback Hardware and select the
Playback module ’IEEE 1394 DVCR Playback’. Restart MoviePack to
activate the selected playback module.

I To play back video clips as DV in your video camera again,
the function DV-In on your camera must be activated. A lot of
new video cameras already possess this input, in many
others DV-In can be activated. Further information on this can
be obtained from your specialist dealer or manufacturer.

I In order to output onto the video camera, the camera’s video
input must be activated. During playback the notice 'DV-Out
Active' appears in the Video Control window.

ï Before you start MoviePack ensure that the camera is
connected to the FireWire outlet and that it is in VCR mode.
As the camera is a part of the Video Capture hardware with
simple DV solutions, you should not switch the camera on
and off during filming as this can cause problems with
Windows.

Sony Vaio The notebook belonging to the Sony Vaio-Product family possess an
integrated FireWire port (IEEE 1394) and the drivers have already
been installed during manufacturing. 

 u Under Tools / Capture / Playback Hardware select the playback
module 'Sony DV Playback'. Restart MoviePack to activate
the selected playback module.
Manual Tutorial Reference Effects
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 u Click the  Show Canvas on Monitor icon in the Video Control window to
output the current content of the Timeline onto the notebook
display.

DPS If you are using the DPS Perception or Velocity video boards, contact us
or view our website to obtain information on the appropriate plug-in
which will give you direct access to your video board. Detailed
installation instructions are enclosed with the plug-ins.

Activating Video Control

u Click the  Activate Video Control icon or from the Window
menu choose Video Control.

After calling up Video Control its memory is still empty. To start the first
rendering of the preview area simply click Play. The preview area is
denoted by a green bar at the top of the Timeline and the Timegraph. To
find out more refer to the ’Reference - Timeline’ booklet.

u If you are satisfied with the material you see in Video Control,
you can transfer it onto a connected monitor. Simply click the

 Show Canvas on Monitor icon.

On the monitor you can appraise your video and determine whether it
is finished and ready to be printed to video tape.

Right-click in the Video Control window and the following menu appears.
Using the check boxes several functions can be activated and
deactivated.

u Make sure that you activate Intelli-Rendering.

As in the Setup menu for Live Preview in
Realtime, under Video Control Setup the
choice of renderer and its settings can
be selected. Under Options file
management, general settings
(schemes) etc can be determined.
Activating Video Control
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u Click the S icon in the Video Control window or select Playback
Setup. In the Format tab you can determine the format size and
select compression options. The selection depends on the
video board you are using.
In the Playback tab you can determine the audio output and
the size of the video and audio preread buffers. We
recommend that you maintain the default setting.

u Click on the red Render button to start the preview rendering
of the preview area. You can follow the results in the Video
Control window.
If sound is included, this is also rendered and played back.

I In contrast to the Preview, your animation must be newly
rendered after each change made to it in Video Control.
Manual Tutorial Reference Effects
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I When rendering in Video Control it is possible to lock tracks.
Click the red circle in the Timeline, it then appears like this .
Activating Video Control
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